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1. Why do I need 3D-Coat?
You may ask: "Why do I need 3D-Coat when there are such cool applications as Zbrush or Mudbox?" 3D-Coat is not designed for creating a human body out of a sphere or a cube. The main focus of the program is detailing and texturing of objects already roughly shaped in another 3D-package. Here you work initially on detailing level equal to 3-5 million of polygons. Use of normal mapping as opposed to geometrical splitting allows for a considerable increase in the editing and objects viewing speed. It is common knowledge that shaping an object doesn’t take long – up to a few hours maximum. However the detailing and texturing are both lengthy, taking 3 to 10 times more than modeling the draft itself. 3D-Coat is designed specifically to speed up this part of the technological process. The program contains tools for sculptural modeling, provides for a considerable change of shape, however detailing remains the key function of 3D-Coat.
Advantages of 3D-Coat:
Painting textures and sculpting. It combines painting layered textures and sculpting in one easy to use interface.
Retopology tools. 3D-Coat combines the most powerful retopology approaches in one package.
3D Layers. Every layer consists of a color, specular, transparency and displacement channel. It has all the layers blending modes as are found in Photoshop.
Calculation occlusion. Built-in fast occlusion calculation tool especially optimized for high polygon count models.
Paint in 3D&2D simultaneously. Built-in 2D texture editor, enables drawing in 2D&3D windows simultaneously. You can paint in 3D then the results will be shown in a 2D window simultaneously and vice versa.
Connection with Adobe Photoshop. It can work in a deep connection with Adobe Photoshop (R) or any PSD editor.
Easy to use. 3D-Coat has an easy and intuitive interface. Every control has a detailed hint, so you can master 3D-Coat very quickly. You can paint a 3D-Model as easily as in a 2D-editor.
Copy/Paste. You can transform parts of the texture, copy/paste, draw with curves, or splines.
Paint tracks and stitches. It has a simple to use method of painting tracks and stitches.
Compatibility. Full compatibility with Light Wave 3D, Modo through .lwo format, with Maya, 3ds Max, Carrara through .fbx and .obj format.
3D mouse support. 3D-Coat supports the 3D SpaceNavigator from 3DCONNEXION.
Adaptive subdivision. The main difference between 3D-Coat and other sculpting software is its adaptive subdivision algorithm. Usually sculpting programs divide every edge into 2 parts, so it is very difficult to work with long polygons. 3D-Coat however subdivides every edge in the source mesh depending on its length. So long polygons may be subdivided in a proportion of   9:147, for example. You can change mesh resolution multiple times (like other software usually does), but also in a percentage, 50%, for example. You paint the vertices in 3D-Coat, but the adaptive subdivision makes the subdivided mesh very uniform. It is preferable that the mesh has no overlapping UV’s, but 3d brush can generate its own UV’s if necessary.
For detailed feature list please visit http://www.3d-coat.com/features.html
The technology of 3D-Coat:
3D-Coat generates a normal map "on the fly" to display fine details. It displays a base mesh of 40-700 K polygons but the normalmap makes it look like 1-16 million polygons. You can edit textures up to 8192x8192.
The usual workflow in 3D-Coat is:
Step1: You load a mesh of 1-700 k polygons with rough details modeled. You can additionally import a displacement texture with smaller details drawn in.
Step2: 3D-Coat subdivides it up to a selected level (0.3-16 millions of polygons). Every polygon is subdivided separately depending on its proportions. At any time you can change the mesh resolution (see Edit->Change mesh and texture resolution). Subdivision can be based not only on multiple times as in other sculpting software but also on a percentage. It is better to increase (not decrease) the resolution during the edit process, as this is more predictable.
Step3: Paint displacement/color/transparency/specularity per new vertex.
Step4: Export normal map/displacement/color/transparency/specular textures. Displacement is exported using the difference of a vertex's position and its position on Layer 0.
Or
- Export baked texture.
Or

- Retopologize and export new mesh and texture.
2. How to learn?
To get the most efficient learning curve and make your life with 3D-Coat easy, it’s recommended that you follow these steps:
Step1: Run 3D-Coat and follow the “Interface basics” interactive video tutorial to understand the basic interface principles of 3D-Coat. (at http://www.3d-coat.com/files/Tut1/Interface.htm )
Step2: Read this manual and follow it to try out every feature step by step. Or if you don’t like read the manual and just want to play with 3D-Coat yourself, keep in mind that there are very detailed hints of every control at the bottom of the interface, with these hints, you can master 3D-Coat very quickly.
Step3: Watch more video tutorials online at http://www.3d-coat.com/video_tutorial.html. Or if you have a low speed internet connection, you can download all video tutorials from here.
Step4: 3D-Coat has a very active public forum. The author really communicates with his users everyday. If you have any question, please post it on the forum, I’m sure you will get approving and quick replies. 
3. Getting started
1. Let’s get a feel for the whole interface first.
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2. Select one of the available OBJ files:
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Or select file menu and click on "Import model", then choose "sample.obj" file (it is in the Sample folder):
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3. If you did all correctly, you will see the window as follows when the file opened:
[image: image5.jpg]To load the model 3d-coat requires one to one correspondence between the texture
and surface points, one point on UV-map should conespond to one and only one pint
on surface. If your object coresponds to that requirement, you should select Keep

UV", But even if your madel have symmetry or overlaps (not self-overlaps) you can
loadl it with option Keep clusters”. 3d-coat wil put al clusters over one texture

without overlaps. Duing the export al textures wil be saved using original uv-
coordinates, so feel free to load objects with symmetry and overlaps. But you shouid
avoid self-overlaps of custers and polygons of complex non-convex shape. If your

model has o vu - mapping, you should choose "Auto-mapping’. But it | better to
map object manualy. If you want to edt arcitectureal or non - organic shapes it is
better to import object without smoothing. In this case you wil be able to export
curent displacement and normaimap,

Obect reading

Millons of polygons ] —
Carcass resolution (polygons) 52608 v
[ smooth object

Mapping type Keep UV o]
UV sub-patches smoothing o smoothing v)

Freserve positions
Ignare smoothing groups
Invert normals

Auto smoothing groups

Uv-set name Defaut

Texture width 2048 0}
Texture height 2048 1v)

ok Cancel





In the window opened there is a set of options you can specify at loading.
By default, the UV-mapping type is "Keep UV". It means that UV-mapping will not vary, and remains as it was. If you want, you can change it. For this example, we will leave it as is.
You can also “smooth” the object while opening the file. For this case, let’s tick "Smooth object".
Slider "Millions of polygons" is responsible for mesh resolution, the number of millions of polygons after mesh smoothing during the loading. This amount should be greater than the amount of pixels on texture. These polygons are used to create normalmap on the fly.
“Carcass resolution (polygons)”: The mesh consists of two levels of detail: carcass mesh (mid - poly mesh) and high resolution mesh. Usually you will see mid-poly mesh in viewport with normalmap created using high-poly mesh.
With the help of “Preserve positions” options you can specify for the initial vertex positions to be saved, compensating their shift when smoothing by extra pressure.
“Ignore smoothing groups” allows for importing meshes without normals information. Model will be entirely smoothed after the import in this case.
“Invert normals” check this option if you want to invert normals of the model.
The “Auto smoothing groups” option allows creating smoothing groups automatically. By specifying value in the “Max. angle” option responsible for the maximal angle between faces when the edge becomes sharp, it is necessary to activate the "Auto smoothing groups" option. To use this option turn the "Auto smoothing groups" on.
Also you can choose textures resolution that will be used for every UV-set of the model. Any time you can change visible texture resolution in Edit- >Change mesh and texture resolution and export resolution in View->UV-sets manager. You can view and edit textures in View->View/edit/tweak textures and UV-sets.
4. When the object is loaded (a wolf-like creature), rotate camera by holding ALT and left mouse key. Move camera with middle mouse key or using combination LMB+RMB (left+right mouse buttons). Move forward and backward by pressing ALT + right mouse key. Try to move camera sideways:
[image: image6.jpg]g ==

ViU rs/a% ¢





5. Point the mouse cursor on "File" menu to see the following command list:
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At first, you can see pin icon at the top left. You can pin any menu for quick access.
−New (Clear current scene and create a new one)
−Open (Opens files of .3b format – the working format of 3d coat files)
−Recent files (Here you can find your recent models have opened by 3D-Coat)
−Save file (Saves files)

−Save file as (Saves files in .3b format)
−Save incrementally (Save file every time into new place - file_001.3b, file_002.3b ... It allows you to save history of your work.)
−Import model (obj, lwo, fbx) (Imports files of .obj, .lwo or .fbx formats)

- Import reference mesh (Import mesh to be reference for retopology tool. This mesh could be additionally deformed using sculpt tool.)
- Import big mesh - Import big mesh (up to 16 M). This function requires 2 meshes - low-poly reference mesh and high poly mesh. They should have the same non overlapped UV-set. You should import low-poly mesh in scene using usual import and then load high poly mesh using this option.
−Merge object into scene (Merge additional object into scene. Be careful with object scale. Don't merge objects with very different scale.)
−Import image plane (see description in the next clause of this section)

−Export model (obj, lwo) (Exports object of .obj or .lwo formats. You can export a low-poly mesh or middle-poly mesh with normalmap)

−Export low-poly mesh with original positions (Export low-poly mesh with original position of vertices)
−Import UV-set (Import object that contains UV-set. The new UV-set will replace old one.)

−Export UV-set (Export object without textures. This command could be used in pair with "Import UV-set". You can export UV-set, adjust it and then import again.)
−Use original UV set (This option is important for models with overlapped UV clusters, for example with mirrored UV’s. In this case you should load the model with "Keep clusters" option on UV-coordinates will be changed in such a way that texture clusters will not overlap each other Models and textures will be exported with the original UV-set if the option "Use original UV set" is checked, otherwise they will be exported with the new UV-set.)

−Save texture (Saves current texture in formats – DDS, JPEG, TGA, BMP and transparency)

−Load texture (Load a texture for current layer without changing the mask of layer transparency, in formats – DDS, JPEG, TGA, BMP)

−Save specular texture (Saves only the specular channel like grayscale)

−Load specular texture (Load specular texture on current layer. It is better to load texture on the layer that has color)

−Save specular as alpha in normal map (Save specular channel to normalmap as alpha-channel)

−Save a world-space normal map (Saves a world-space normal texture)

−Save normalmap (tangent space, low-poly mesh) (Save a local-space normal map for the low-poly mesh)
−Save normalmap (tangent space, Layer0-based) (Using this option you can export normalmap without artifacts on edges because tangent space is based on layer 0, not vertex - based like in other options.)

−Save normalmap (tangent space, mid-poly mesh) (Save a local-space normal-map for the mid-poly mesh (after subdivision)

−Load normalmap (tangent space) (Import normalmap. This normalmap WILL NOT affect any geometry. Normalmap will be loaded on new layer and blending operation. "Normalmap" will be applied to the layer)

−Save displacement - depth of current layer (You can save depth of current layer to texture, edit it in graphical editor and load it again. This texture can also be used as displacement-map)

−Save displacement - depths of visible layers (You can save depths of visible layers to texture, edit it in graphical editor and load it again. This texture can also be used as displacement-map)

−Load depth texture into the current layer (You can load texture of depth into the current layer. You have to enter factor - multiplier of depth. If you have saved texture, you can look this factor up in a file ExportDispHistory.txt)
−Save vector displacement (Save vector displacement as RGB 16/32 bit tiff/exr files.)
−Load vector displacement (Load vector displacement from RGB 16/32 bit exr/tiff file.)
−Texture baking tool (Find its detailed description in chapter 16)

−Export a high-poly mesh(x4 poly) (Export a high-poly mesh – the number of polygons is 4 times higher than in a mid-polygon mesh)

−Export a high-poly mesh(x16 poly) (Export a high-poly mesh – the number of polygons is 16 times higher than in a mid-polygon mesh)

−Export a high-poly mesh(x64 poly) (Export a high-poly mesh – the quantity of polygons is 64 times higher than in a mid-polygon mesh.)
−Exit (Exiting the program)
6. 3D-Coat can also be used to edit 2D images and adding relief to them. Call ''Import image plane'' to open a window where you specify ''Depth texture'', ''Color texture'' and ''Depth scale'', from where you load the depth texture.
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Using the ''Import image plane'' tool together with ''Edit'' – ''Offset tool'' you can loop the textures. Currently only square textures are supported. This option is very useful to make tiled displaced textures.
7. With the help of Navigation tools located on the second top right panel you can:
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Adjust light ambient by holding LMB and moving the mouse.
Adjust light brightness by holding LMB and moving the mouse.

Move light by holding LMB and moving the mouse.

Rotate camera by holding LMB and moving the mouse. To rotate camera without this control, use ALT+LMB.

Scale scene by holding LMB and moving the mouse. To scale the scene without this control, use ALT+RMB.

Set camera to default position.

Toggle perspective/ortho projection.
8. You can see different viewing choices for your model in dropped list [camera], such as: Front, Back, Left, Right, Top, Bottom and shortcuts commands:
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Add camera shortcut. The information about camera position and current material placement will be stored.

Delete camera shortcut. Delete last used or added shortcut.

Switch to previous shortcut. Switch to previous camera and material shortcut.

Switch to next shortcut. Switch to next camera and material shortcut.
4. Pen
1. Let’s try drawing on an object. Point the cursor onto the pen icon:
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2. Choose a pen you like from the list of pens. This is a list of standard 3d coat pens. You can add your own pens in TGA or ABR format (the pen format used in Adobe Photoshop). Press on the "Folder" icon to add a pen. The pen added will appear in the list of pens available. You can use a 3D-model as a pen. A pen can be colored, provided the image contains alpha-channel. In this case the alpha-channel will be used as a mask for depth. Use ''CTRL'' or ''SHIFT'' to select several pens that will be used randomly. In this case you will see several pens on the preview:
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3. In the pen selection mode you can adjust the pen for further use.
4. In order to change pen radius use key "[" and "]" or mouse wheel (provided the correspondent adjustments were made in the Options menu); to change depth press "-" and "+" or mouse wheel (provided the correspondent adjustments were made in the Options menu). You can do the same using sliders in the top pen panel.
5. Choose a pen, set radius ''20'' and try drawing on an object.
6. Increase radius, choose another pen shape and draw a bit more. Use ''T'' key quick access the pen menu.
7. First press "SHIFT" and draw again. You will see the surface getting smoothed. Change the smoothing intensity using the "Smoothing" slider.
8. First press and hold on LMB then press "SHIFT" and draw again. Then you are able to draw very straight line just like the way in Photoshop.
9. Click "CTRL" and draw – instead of convexities dents are being drawn.
10. You can change the pen rotation angle with the help of "Rotation" slider. Parameters of rotation range from 1 to 360 degrees. You can also use hot keys "(" and ") or the mouse wheel (under correspondent settings in the "Options" menu) to rotate the pen counter clockwise or clockwise accordingly. You can see the red line rotating on the pen cursor when "(" or ")" is pressed. If you choose an asymmetrical pen shape then this rotation shows the pen orientation:
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11. ''Soft stroke''. In this mode strokes will be more accurate because of additional smoothing of trajectory.
12. Open up the pen pressure dependence on color list. Here a choice of 16 components is provided:
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-Pressure does not depend on color (when using this option the surface color does not impact the pen pressure. This is the default option)
-More on RED channel (The pen pressure depends on the value of red surface color channel by formula "Pressure=Pressure0*(RedColor – AverageColor)/128")
When choosing this command (or one of the below listed ones) you will see a slider in which the average color value can be specified:
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This value is used in case the application of pressure dependence on surface color is selected. In order to obtain this value from the model surface use "Pick" function, i.e. point the cursor onto the necessary place and press "V" key.
-Less pressure on RED channel (The pressure depends on red channel by formula "Pressure=Pressure0*(AverageColor – RedChannel)/128")

-More pressure on GREEN channel (The pressure depends on green channel by formula "Pressure=Pressure0*(GreenChannel – AverageColor)/128")

-Less pressure on GREEN channel (The pressure depends on green channel by formula "Pressure=Pressure0*(AverageColor – GreenChannel)/128")

-More pressure on BLUE channel (The pressure depends on blue channel by formula "Pressure=Pressure0*(BlueChannel – AverageColor)/128")

-Less pressure on BLUE channel (The pressure depends on blue channel by formula "Pressure=Pressure0*(AverageColor – BlueChannel)/128")
-More pressure on BRIGHT channel (The pressure depends on pixel brightness by formula "Pressure=Pressure0*(AverageColor – (Red+Green+Blue)/3)/128")

-Less pressure on BRIGHT channel (The pressure depends on pixel brightness by formula "Pressure=Pressure0*((Red+Green+Blue)/3 – AverageColor)/128")

-More pressure on CURRENT channel (The closer the surface color is to the current color, the higher is the pressure. The "color distance" determines the preciseness of measuring)

-Less pressure on CURRENT channel (The closer the surface color is to the current color, the lower is the pressure. The "color distance" determines the preciseness of measuring)

-Pressure depends on mask (In this mode the pressure is less in areas where something is already drawn)
-More on heights (The pressure is more on more height details of current layer. Only depth of current layer is taken into account.)
-Less on heights (The pressure is less on more height details of current layer. Only depth of current layer is taken into account.)
-More on cavity (The pressure is more on cavity.)
-Less on cavity (The pressure is less on cavity.)
13. All the listed modes are useful, if there is no map of depth and/or map of specular under your texture. Hence, as an example of a different usage, let’s make a map of depth and/or a map of specular for a square-shaped texture. To do this, just click “import image plane” in the file menu, click to select a image for the Color texture. You will be offered the choice as follows:
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Click Ok:
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Then in the pressure dependence on color list choose “more on BLUE channel”:
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and draw with the pen. You will see depth changing in accordance with blue color:
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Using all these options you can easily create a map of depth and/or specular for a ready-made texture.
14. Using the drop-box "Parameters of the current pen" menu you can specify:
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Every slider has small pen icon nearby. Check it if you want that parameter will depend on pen pressure. The list of parameters:
−Depth modulator. It is needed to specify the standard depth for each pen in use.

−Rotation amplitude. The amplitude of addition random pen rotation.
−Radius variation. The degree of random pen radius variation (in percent).

−Depth variation. The degree of random pen depth variation in percentage.
−Opacity jitter. Jitter of Opacity.
−Jitter. Jitter of the pen.
−Random flip X. Flip pen randomly along x-axis.

−Random flip Y. Flip pen randomly along y-axis.
−Draw by spots. By this option a moving pen will draw with separate spots, as opposed to stretching lines.
−Rotate along motion direction. If this option is used, the pen slopes in the direction of motion. If you rotate the pen manually, the angle of rotation will be added to the incline angle as a result of pen motion.
−Skip eraser. Don’t use eraser layer of the pen.
−Use spacing. In case this option is used, drawing with pen movement will be done with patches placed at equal intervals from each other.

−Spacing. 
15. By pressing the right mouse button on any of non-standard pens you will see the advanced menu as follows:
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You can:

-Delete pen.

-Save to PSD/TIF (Store pen to PDS or TIF-16 bit. PSD is more intuitive, TIF is more precise. TIF file contains 7 channels - RGB, Alpha, Height, Specular and Erase mask). Read about layers structure below.

-Load from PSD/TIF (Load pen from PDS or TIF-16 bit. TIF file can contain up to 7 channels. The table shows how different amount of channels will be treated:

If there is:
1 channel: treated as Alpha and Height.

2 channels: 1 – Alpha 2 –Height

3 channels: 1, 2, 3 – RGB, 2 – Alpha, Height

4 channels: 1, 2, 3 – RGB, 4 – Alpha, Height

5 channels: 1, 2, 3 – RGB, 4 – Alpha, 5 – Height

6 channels: 1, 2, 3 - RGB, 4 – Alpha, 5 – Height, 6 – Specular

7 channels: 1, 2, 3 – RGB, 4 – Alpha, 5 – Height, 6 – Specular, 7 – Erase mask
In case PSD file has no structure as described below, it will simply be unrecognized by the program.

-Edit in ext. editor. Edit the pen in external editor (Adobe Photoshop by default). A PSD file will be saved and it will be loaded automatically after change. As soon as you save the file, 3D-Coat automatically catches up the pen. In Adobe Photoshop pen has the structure as follows:
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A pen includes four layers – Color, Height Map, Specular Map (Specular), Erase Map (EraseMask). Let’s see to these layers individually:

Color – contains pen color and transparency mask. The transparency mask affects specular channel as well (Specular).

Height Map – contains pen height map. Grey color RGB(127,127,127) corresponds to zero height. Darker colors correspond to cavities, lighter colors – to convexities.

Specular. While color corresponds to maximum specular, black one – to absence of specular. Keep in mind, the color map transparency mask gets applied onto the specular map too.

EraseMask. This mask allows erasing the layer contents on mask before pen drawing. This may be used to create pens which would not be colliding with each other when drawing. An effective application would be interstice, chaps on skin, fabric. Keep in mind the erase mask affects the lowest layer.
-Edit as 16 bit TIF 
- -->NewFolder. [ Copy pen to another folder previously created by you (--> sign means

copying)]
16. Additionally, ''Radius'', ''Falloff'' sliders (and some other ones described below) are located on the top panel and can be minimized as follows:
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17. Also there are two locks icons on the top panel. Using lock icon near the radius slider you can lock visible on screen radius of the pen. It is convenient when you want to change radius of pen simply moving the model back and forward. The lock icon near depth slider allows you variety pen radius without variation of absolute pen depth. In standard mode radius and depth are proportional. You can look the lock icons on screenshot below:
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18. Every slider has small pen icon nearby. Check it if you want that parameter will depend on pen pressure
19. Use the drop-box list “[command]”, you can add, rename or delete a folder:
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Add new folder: Create a new folder.
Add existing folder: Add pictures from folder with pictures. New pens/strips folder with the same name will be created. You should select at least one file in the folder and all files from the folder will be added to list.
20. Using the drop-box list "default", you can save in separate folders your set of pens (and strips in ''Strip'' menu, materials - ''Material'' one):
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21. Press on "Folder" icon to add a new pen. Pen can be created from a picture or a 3D model. In case you use BMP file as a pen, the pen depth and transparency will be taken from green channel of the picture. In case the source file has TGA extension, the color of picture will be used in the pen color channel, while alpha channel – as depth map and transparency mask. The upper left pixel on the image will determine zero height. If OBJ file is used as a pen, you will see the dialogue as follows:
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In this dialogue a model can be rotated and scaled. Rotate the model by pressing left mouse button, move the model while holding spacebar, scale it with right mouse button, rotate within the screen frame by using the combination of ALT+ left mouse button. You can choose texture size and the image proportions. The use of non-square pens is especially handy when creating strips as described below. Using slider in the right lower corner you can adjust the level of model dipping into the background plane which determines the zero pen level.
5. Strip
1. With the help of "Strip" menu you can select a shape of strip to be applied along the drawing trajectory. This may be used to draw decorative edging or a chain.

2. The prohibiting red sign means no strip will be applied along the trajectory.

3. Click on "Folder" icon to add a new strip. Creation of new strip is fully similar to creation of new pen, as described in section (4-21).

4. In the following example we used drawing a spline with correspondent strip shape applied:
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6. Masks
1. The mask is modulator for pen depth and transparency. The mask and materials could be moved and rotated independently using new navigation controls. Masks and materials could be rotated discretely on 45 degrees using ''SHIFT''.
2. Pay attention, if you choose to display mask/material in at least one of the channels (depths and/or, colors and/or specular, see more detail about them below) a new panel shows up on top:
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2.1 Using this panel you can manage the Masks/material preview parameters:

-"Hide/Show/Auto"–hide/show/auto-hide full-screen view of texture. You can switch regimes with the hot key ''H''. 

-''Unlock/Lock'' – allows to scale and texture automatically while scaling and moving the model.

- "Reset" – place texture in initial position.

- "Flip X" - reflect texture mirror-like across.

- "Flip Y" - reflect texture mirror-like along vertical axes. 

-There is also a switch to change the type of Masks/material application onto object:
From camera (the Masks/material will be projected on the object from camera) and cubical (the Masks/material will be applied by cube mapping). If the ''cube mapping'' application type is selected, the material preview will be displayed on pen only, as opposed to full screen (when ''From camera'' is selected). To the right there is a slider responsible for transparency when viewing the Masks/material.

- Opacity of preview (in percents).

- You can select there what will be transformed using navigation panel: material or mask.
2.2 The following picture shows the ''From camera'' Mask application method in action:
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3. Click on "Folder" icon to add a new mask. Creation of new mask is fully similar to creation of new pen, as described in section (4-21).
7. Material
1. Point cursor onto the square under "Material" icon. The "Material" menu contains three channels: depth, diffuse and specular. On each channel you can put your own texture. By choosing a material and texture you will see the whole screen filled with this texture.

2. You can add your own materials by choosing the "Folder" icon (material must be in format of BMP, DDS, JPEG or TGA). The prohibiting red sign means no using of the material. Quick-access the "Material" menu by pressing "M" key. Select any material from the list and have some drawing. (In the example below, we only want to paint color texture to the model, so I disabled depth and specular channel. You can enable every channel when needed.)
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3. You can see the power of the “Material” as the picture (by Pavel Zoch) shown below:
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8. Depth
1. Point the cursor on "Depth" icon. By pressing on red sign you will forbid changing the depth channel while drawing. By choosing the "hill" icon, you will allow editing in the depth channel; however no extra texture will be allowed for overlay in the channel. The question-marked folder means that an extra depth channel texture used for overlay while drawing has not been selected. If the texture is selected, the question-marked folder is changed with a texture-imbued square. Press on the folder to replace your texture:
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2. "Additive drawing" option allows activating/deactivating additive application option when drawing lines. If "Additive drawing" is active, two lines are drawn one over another. Notably, if the option is disabled, cross is made with objects drawn in the current layer only.
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3. Red line on the pen cursor displays the depth of relief lying. Press "-" and "+" keys or mouse wheel (under corresponding adjustments in the "Options" menu) to see how the depth changes.

4. If the pen is of complex shape, less pressure should be applied to prevent steep overfalls of image height. On a side note, it would make it hard to present the entire object as normal-mapped low polygonal one, heavy geometry distortions will be seen.

5. With the help of "Smoothing" slider you can change the level of smoothing. By pressing "Shift" key green line will appear on the pen cursor and by pressing "Shift" + "+" and "-" keys or mouse wheel (provided corresponding adjustments have been made in the "Options" menu) you can adjust the level of smoothing.

6. Pay attention, on the right panel there are inscriptions "Depth", Color", "Specular". Point the mouse cursor onto one of them. You will see the menu as follows:
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depending whether the material was selected.
7. Pressing on a red sign (the first in the list on the right) you will forbid changing the correspondent channel when drawing, be it depth, diffuse or specular. By choosing the second icon in the list on the right (image of "hill" or "sphere", changes depending what channel you work in), you will enable editing in corresponding channel, however without overlaying additional texture in this channel. You will draw with a pen not distorted by material. The question-marked folder icon means that additional texture in corresponding channel, used for overlay when drawing, was not chosen. If the texture is chosen, the question-marked folder changes to a square with a texture of depth, color or specular (depending on channel you work in). Try choosing the ''hill'' icon in depth channel and draw a bit, then opt for square with texture and draw. The difference will be obvious.

- To quick-access such menu press ''D'' (depth menu), ''C'' (color menu), ''R'' (specular menu). Use "~" key to quick-access the semi-transparent panel containing parameters for all the three channels in compact form.

- The "Folder" icon allows you to set another texture in corresponding channel for the current material. If you set the texture for diffuse channel, bear in mind that the texture alpha-channel is used as additional mask when laying color.

8. You can see the power of the “Depth” as the picture (by Juan Carlos Montes) shown below:
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9. Color
1. Point the cursor on "Color" icon. By pressing on red sign you will forbid drawing by color for the current texture. Pressing on a green sphere icon you enable editing in diffuse channel, but with no extra texture overlaid in the channel. The question-marked folder means that no extra diffuse channel texture used for overlay while drawing has been selected. If the texture is selected, the question-marked folder is changed with a texture-imbued square. Press on the folder to replace your texture:
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2. The "Transparency" slider is the transparency applied to pen color while drawing. You can reduce or increase the transparency using hot keys – "О" and "Р" accordingly. You can see that depending on transparency the segment color changes on pen cursor. The segment acquires blue color and its size depends on transparency.

3. Point the cursor on the drop-list to see the following:
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Here you can determine the rule of color selection for drawing. You can draw with a main color, or you can use a mix of the main and background colors:

-Use current color (use main [current] color to draw)

-Use randomly one of two colors (use one of two colors (current or second one) randomly to draw)

-Use random color between two (use a random mix of two main colors)

4. Here is an example (by Juan Carlos Montes) has used “Color”:
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10. Specularity
1. Point the cursor on "Specularity" icon. By pressing on red sign you will forbid drawing with specular. By choosing the shining sphere icon you will enable drawing in specular channel, however with no additional texture overlaid in the channel. The question-marked folder means that no extra specular channel texture to be overlaid while drawing has been selected. If the texture is selected, the question-marked folder is changed with a specular texture square. Press on the folder to replace the specular texture for your current material:
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2. With the help of "Specularity" slider you can change the reflective qualities applied while drawing. The hot keys ''<'' and ''>'' or mouse wheel (under corresponding adjustments in the ''Options'' menu) allow changing the "Specular" parameter quickly.

3. The "Opacity of specularity" slider is responsible for change of transparency applied to reflective qualities. The hot keys ":" and "/" or mouse wheel (under corresponding adjustments in the ''Options'' menu) provide for specular transparency decreasing or increasing.

4. You can see the specular effects from the image (by wailingmonkey) below:
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11. Pick Color
1. Now we need to learn how to use the color correctly. For this, point the cursor on the "Color" icon and click on a square under the "Color" inscription:
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2. You will see a panel for choosing color, select the color you like.
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This color will paint the square you pointed at. It shows the current color. You can choose the second color too: click on an icon right next to the first color icon in "The color" box (on this picture the first color is green, the second is black). The second color is used in the diffuse channel (menu "Texture") while you work with the drop-list. Apart from standard set of color options, the "Pick color" window contains various color selection modes: HSL and IMG (selection from image). For the latter one, there are additional buttons available:
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-With the icons left top of the image, you can pan/zoom/reset the position of the image.
-Select. Select image from file.

-Paste. Paste image from clipboard and use like custom picker.

-Select image from list.
In addition: For a fast choice of color you press and hold "B" key (when calling it this way, you open the downsize “Pick color” window, same as when calling from the “View” - “Popups” - “Color picker” mode). Right mouse-click to disable\enable use of color. It is equivalent to choosing white color. You can take color directly from a surface, point the cursor on a corresponding place and press "V".
3. You can also pick color from “Palette” window:
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Click on the drop-list, there are 3 preset palettes:
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Click to select color or right-click to change properties color:
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You can add new palette in format ACO too.
12. Types of drawing
1. Point the cursor onto "Type of drawing" menu to see 15 drawing modes available:
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2. The first five modes are used with drawing tablet plugged in: 

− Change pen width and depth depending on pen pressure applied while drawing. 

− When drawing lines, width remains the same, however depth differs. 
− Alter pen radius, depth and opacity depending on pen pressure.
− Droplet mode. Increasing pressure decreases radius and grows depth and opacity.
− Same width and depth regardless of pen pressure applied.
3. The next three modes are drawing with dots, lines and curves: 

− Draw with separate dots (this mode allows drawing point by point). 

− Draw straight lines from point to point (in this and the next mode, press ''ESC'' to start drawing a line from the beginning or ''CTRL-Z'' to return to previous point). 

− Draw with splines from point to point. The lines and splines drawing mode always uses crossing, as opposed to additive drawing. This continues until you switch from lines drawing mode into another one.
4. Stamp: in this mode stamp follows the mouse (pen) without leaving traces. You can rotate the pen using ''('' and '')''keys or mouse wheel (under corresponding adjustments in the ''Options'' menu), change pen size and see how the stamp is going to be applied onto object. We recommend using the Stamp mode with "Additive drawing" option located in the depth channel menu disabled.
5. The concluding five modes are drawing by contours: 

− Draw with rectangle.
− Draw with contour of lines. Press to add points. Press on the initial point or double-click to finalize the contour. Press ''ESC'' to cancel the contour, ''BKSP'' to delete the last point. 

− Draw with continuous contour. Press left mouse button to draw contour. 

− Draw with ellipse. 
− Draw by closed spline.
Here’s an example of drawing with contour of lines:
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6. The last draw mode – paint over source polygons. There is an example of using:
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7. The ''Border width'' slider is responsible for border width when drawing with rectangle, ellipse or contour.
8. The ''Ignore back faces'' switch – no drawing on the back, invisible part of surface. This option is available only when drawing with rectangle, ellipse or contour.
13. Tools panel
There are several tools available (Quick access by press “spacebar”):
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1. Brush icon is drawing by default: Draw with a pen:
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2. Pulverizer icon: Draw with expansion (A mode of drawing with accumulation):
[image: image57.jpg]
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3. To perform various color operations, choose command:
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3.1 A panel of color modifier parameters will show up on top:
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3.2 You will see these operations:

−Desaturate (color reducing). When you press CTRL the opposite action is performed – colorize.

−Saturate (increment of chromatic level). When you press CTRL the opposite action is performed – desaturation

−Darken (color darkening). When you press CTRL the opposite action is performed – lightening.

−Lighten (increment of brightness). When you press CTRL the opposite action is performed –darkening.

−Sharpen (sharpen the color). Use CTRL to smooth.

−Smoothing (soft smoothing). Use CTRL to sharpen the surface.

−Increase hue. Increase hue (use CTRL to decrease hue). The transparency determines the degree of hue change.

−Decrease hue. Decrease hue (use CTRL to increase hue). The transparency determines the degree of hue change.
3.3 Draw on an object using color then choose the "Darken" command. Draw again on the object in the same place to see how your current color darkens. Try different color operations modes.

3.4 The "Transparency" slider on the top toolbar is responsible for degree of color modification while drawing. Use hot keys "О" and "Р".
4. Magnification or reduction of layer height:
[image: image61.jpg]



4.1 Choose the operation on layer height (increase or decrease). When drawing, it is only the current layer height that is changed. Press ''CTRL'' to perform a revert operation. As pen shape, so as line and material are taken into account when drawing.
4.2 Additional options:
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Here’s a choice of operations with current layer height provided:

−Magnification (The layer height is increased while drawing; hold CTRL to have it decrease).

−Reduction (The layer height is decreased while drawing; hold CTRL to have it increase).
4.3 "Degree of change" slider on the top toolbar is responsible for the degree of height change. The maximal value (1) corresponds to height increase or decrease two times.
5. Shift layer in tangent space:
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5.1 Shift layer in tangent space – smudge, collapse, expand. All operations will be applied in screen space, so you should try to place modified place at the best view position. This tool is intended to move only small details over the layer, don't use it to move big blobs.
5.2 Additional options:
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- Smudge (Smudge layer along motion).
- Collapse (Collapse layer. You should move pen to apply this operation).
- Expand (Expand layer. You should move pen to apply this operation).
6. Clone tool:
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6.1 Press ''CTRL'' and left mouse-click to mark a source point for copying. Then draw using the left mouse button. You can copy not only with round pen, but also with frame and contours (press ''E'' to check it out).

6.2 Additional options in the ''Clone tool'' menu:
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6.3 You can clone not only with standard translation, but also through various other operations:
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-Translation (In this mode press ''CTRL'' and left mouse-click to select the source point): 

Dx – the horizontal shift of source point.

Dy – the vertical shift of source point.

Example:
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−Mirroring (Copying with reflection of a plane. Press ''CTRL'' and left mouse-click to select the point for the plane to go through).

Example:
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−Inversion (Copying with inversion against the point. Press ''CTRL'' and left mouse-click to mark the center point of inversion): 

Center X and Center Y - positions of pivot point on screen. Press ''CTRL'' and left mouse-click in corresponding place to change it.

Example:
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− Clone sector (Copy a sector rotated at some angle against the pivot point. Press ''CTRL'' and left mouse button mark the rotation center point. This mode can be used to multiply a pattern drawn in one sector all around):
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Center X and Center Y are positions of control point on screen. To change its position, press CTRL and left mouse button in corresponding place.

Amount of sectors – amount of sectors when cloning a pattern in a sector.

Counter clockwise – when enabled, the sector will be copied counterclockwise.
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− Symmetrical copy (Symmetrical copy allows to copy surface from one side of model to symmetrical one. Press 'S ' and activate symmetry before using this tool.)
Example:
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− Copy using pen (Copy using pen allows to copy using topological symmetry. You should setup topological symmetry before using this tool. Topological symmetry can be defined in Topological symmetry tool by selecting two symmetrical faces.)
7. Transform/copy tool:
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7.1 Drag the frame and select an area to be transferred. The frame acquired can be dragged, or rotated. Use ''SHIFT'' to preserve proportions. Use ''CTRL'' to drag vertices independently of each other. Press ''ESC'' to cancel the transformation and ''ENTER'' to apply it. This mode is good to use in combination with frame, circle and curves (press ''E'' to open the draw types menu). The border width determines the edge softness when transforming. By disabling channels (depth, diffuse, specular) you can transform the remaining channels only. In the transform mode the surface area gets erased from its old place and copied onto the new one. In order to simply copy without deleting, do not tick the "Erase old position" option. It is possible to transform whole block of visible layers and paste them merged or separately. You can select what to copy not only with rectangle but also using freehand selection as it shown below.
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7.2 Other options:

Depth modulator. Additional depth modulator for transformed area. 
Opacity modulator. Additional opacity for transformed area. 
Specular modulator. Additional specular modulator for transformed area.

Store. Store transform parameters and image to InstallDir\UserData\StoreData\Rects\

Restore. Restore transform parameters.

Export. Export to PSD – file.

Import. Import from PSD – file.

Edit. Edit image with external editor that should support PSD - files. By default it is Adobe Photoshop.
8. Copy/Paste mode:
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When calling this command, an advanced menu will pop up:
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− Copy/Paste. You can copy parts of surface to clipboard using "CTRL''+''C" and then paste them using ''CTRL''+''V''. If the cursor is not pointing on an object, it will be pasted to the same place it was copied from. Images in clipboard can be edited in another graphics editor, then put back to clipboard and pasted onto the object surface. If the color channel is open for editing, the color texture is placed to clipboard; if it is disabled, then the depth texture will be placed into clipboard; in case the depth is disabled for editing, then specular texture will be placed there. Hence, you can copy and edit in a different graphics editor any of the channels depth, specular or diffuse. If you press "CTRL"+"SHIFT"+"C" a new pen is made from a surface part and gets added to the pen list. When you press "CTRL"+"SHIFT"+"V" the mirror reflected part is pasted. Bear in mind that copying and pasting are pen-turn sensible. Copying and pasting objects with the help of hot keys is not limited to Copy/Paste tool, but is possible in any other mode.

− Store. Save the clipboard image into a file.
− Restore. Loads the clipboard image from a file using these functions you can create a library of stamps. Load a plane or a cube, for example, draw a button or a rivet, then save to a file. As relief, so as color and specular will be saved too.
9. Draw with spline:
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You will see additional menu "Curve parameters" pop up:
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9.1 Parameters of curve
- Curve profile
[image: image80.jpg]Curve profile
Uniform

Uniform

sharp

Obtuse (flatten)

Arrow.

Arrow back

Double arrow

Arrow (mod)
Back arrow (mod)
Double arrow (mod)
Arrow (mod1)

Back arrow (mod1)
Double arrow (mod1)
Sinual





Uniform – the curve with no linear modulation.

Sharp – the curve sharp on edges.

Obtuse (flatten) – the curve flattened on edges.

Arrow – one kind shape of arrow.

Arrow back – one kind shape of arrow.

Double arrow – one kind shape of arrow.

Arrow (mod) – one kind shape of arrow.

Back arrow (mod) – one kind shape of arrow.

Double arrow (mod) – one kind shape of arrow.

Arrow (mod1) – one kind shape of arrow.

Back Arrow (mod1) – one kind shape of arrow.

Doulble arrow (mod1) – one kind shape of arrow.

Sinual – one kind shape of arrow.
−Ignore back faces. When this option is activated, you draw only on visible part of the surface.

−Closed curve. Close the curve.

−Use spacing. Points will be set along curve with some spacing and jittering. It allows you to make new effects with curves.

−Toggle hardness. This mode allows you to toggle hardness of the vertex in spline by click on he vertex. ''ESC'' cancels this mode.

−Profile parameter. This parameter affects the linear curve profile in case you selected the sharp or obtuse profile.

−Depth modulator. Modulator, impacting the entire curve depth (height).

−Width modulator. Modulator, impacting the entire curve width.

−Opacity. Transform current combination of points to circle if possible.

−To line. Transform current combination of points to line if possible.

−Subdivide. Subdivide curve.

−Equalize. Set equal distances between points.

−Store. Save curve to a file with CURV extension, placed into:

InstallDir\UserData\StoreData\Curves\ by default.
−Restore. Load curve from a file with CURV extension, located in:

InstallDir\UserData\StoreData\Curves\ by default.
9.2 Moving the whole curve:
Use the 3 icons on the right bottom of “Curve parameters” menu; you can rotate/move/scale the whole curve.
[image: image81.jpg]



Rotate curve as a whole. You can also use ''CTRL'' and drag point to rotate the whole curve.
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Move curve as a whole. You can also use ''SHIFT'' and drag point to do this.
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Scale the whole curve.
9.3 In order to draw with a spline, we shall determine a spline of several points first. When pointing the cursor onto one of the blue dots, it gets highlighted. By mouse-clicking you can capture it and drag in a new position. Click again to release the control dot. Splines are handy to use together with stripes to carefully draw a chain or a string of riveting. Click "Enter" to apply the spline onto object:
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Left mouse-click to add new points in the spline. Use "ENTER" to draw a curve, "CTRL"+’ENTER" for to draw a curve with inverse depth. Use "BKSP" to delete the last point, "ESC" to delete all points.
9.4 You can draw arrows in easy way.
[image: image85.jpg]U spacng

e ot
—
Profe psmater

Depth modator
yodth modkdater
Opsaity modudator

| Toade [  Toe
(oo
Y
T
D+ P





9.5 Spacing mode. Points will be set along curve with some spacing and jittering. It allows you to make new effects with curves.
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9.6 Curves will be drawn correctly, even if knot points are far from each other and surface between them is curved much.
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9.7 What to do?:
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With “Draw with spline” tool, you are not only able to paint and extrude, but also can:
-Erase (Erase the current layer along the curve)
-Freeze (Freeze along the curve. CTRL+ENTER – unfreeze)

-Planarize (Planarize the surface along the curve)

-Set absolute height (Apply plane tool along the curve and then apply usual extrusion. It looks like setting the absolute (not relative) depth along the curve.)

10. Putting text on the curve:
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10.1 If you choose this mode you will see such menu:
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Using this menu you can select the font for text, input the text, so as change parameters of the curve the text is applied along:

−Ignore back faces. When this option is activated, you draw only on visible part of the surface.

−Closed curve. Draw closed curve.
−Flip text. Flip the whole text.
−Depth modulator. Modulator, impacting the entire curve depth (height).

−Width modulator. Modulator, impacting the entire curve width.

−Opacity. Transform current combination of points to circle if possible.

−To line. Transform current combination of points to line if possible.

−Subdivide. Subdivide curve.

−Equalize. Set equal distances between points.
−Toggle hardness. This mode allows you to toggle hardness of the vertex in spline by click on the vertex. ''ESC'' cancels this mode.

−Store. Save text and font, from a .txt file, placed into InstallDir\UserData\StoreData\Texts\ by default.

−Restore. Restore text from a .txt file, located in InstallDir\UserData\StoreData\Texts\ by default.
10.2. Add new points into the spline by pressing left mouse button. Use ''ENTER'' to draw convex text over the curve, ''CTRL''+''ENTER'' for pressed-in one. Use ''BKSP'' to delete the last point, ''ESC'' to delete all points. Click on the blue sphere to move it.
10.3 With “Putting text on the curve” tool, you are not only able to paint and extrude, but also can Erase/Freeze/Planarize/Set absolute height. (The same description as 8.7)
10.4 You can apply the text on any place of the object, for example:
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11. Put picture along spline. If picture is tiled you can put it several times:
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11.1 If you choose this mode you will see such menu:
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Using this menu you can select images used for Depth texture/Color texture/Specular texture, put pictures along spline. There are several parameters:
-Number of tiles. Specify the number of tiles. You can see the difference with number of tiles higher or lower:
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- Falloff. Opacity falloff.
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- Extrusion. Extrusion of the whole texture.
The other parameters are the same as in “Draw with spline” tool described in 8.1.
11.2 With “Put picture along spline” tool, you are not only able to paint and extrude, but also can Erase/Freeze/Planarize/Set absolute height.
12. Erase – erasing the color, geometry or specular in current layer:
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The range of erasing depends on the scroll box "Erasing degree":
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Erasing does not affect the lower layer.
13. Hide- Make some faces invisible:
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To hide the necessary parts of surface, use this command.
13.1 Pressing a pen, hide parts of the surface by painting on the model. Pressing with "CTRL" shows previously hidden surface areas. "CTRL+X" to unhide all. "NUM+", "NUM-" makes the hidden area wider narrower.
13.2 Using additional ''Hiding'' menu you can store/restore the hidden areas configuration:
[image: image99.jpg]Hiding




13.3 In case you used save/load command, a drop list ''[choose file]'' will appear, so that you could choose the file required:
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13.4 For example, the command can be used to comfortably map a texture in beast’s jaws:
[image: image101.jpg]



13.5 You can get more advanced commands through “Hide” of main menu:
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For convenience, you can pin this context menu by click the pin icon (click again to unpin), move it to the position you want, for example:
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With this context menu, you are not only able to hide surfaces by painting on the model, but also can hide the whole object by selecting the object you want to hide. For example, if there are several sub-objects in the scene, you can use “Hide sub-object” to hide specific object, as the picture shown below:
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If there are only one object in the scene, ”Hide sub-object” will hide that object
You can also hide faces by specific material, use “hide some material”, there are also a pop-up menu:
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Select one material from this menu, then all the surfaces with that material will be hidden.

The other commands are very easy to understand through literal meaning, you can try and see the results yourself.
14. Freeze surface mode:
[image: image106.jpg]



This is a mode of freeze of surface parts to prevent their subsequent change. Freeze mode can be conditional, for example for relief, flat or colored parts depending on mode selected. Blocking masks the action of feathers. Freeze mode is an operation opposite to selection. Choose the freeze mode and draw on object. Notice that you draw with a freeze. Press SHIFT to smooth out the edges of blocking.
14.1 When calling the blocking mode you will see the freeze menu as follows:
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14.2 Point the cursor on the ''Freeze all'' dropping menu. You will see the following menu:
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This menu provides for a surface freeze mode selection. When the pen goes along the surface, it gets blocked in accordance with the condition you choose in this menu. There are five blocking modes in total:

-Freeze all. Block with a touch of pen or mouse-click (default mode).

...convexity. Block convex parts of surface.

...concavity. Block concave parts of surface.

...not key color. Block all, but for the color selected as current.

...key color. Block color selected as current.

Use "CTRL" for all types of blocking to unfreeze.

14.3 There exist six commands of freeze modification:
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Freeze the whole surface (freeze all the surface according to the currently selected. Hot key – "ENTER")

Unfreeze all (Hot key – "CTRL-D". Can be used in all modes)

Invert freeze / selection (invert freezing. Hot key – "CTRL+SHIFT+I'') 
Show/hide freeze. (Show or hide freeze preview)

Smooth freezing (blur)

Sharpen freezing (sharpen)
14.4 There are three sliders on the freeze panel:
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The first is ''Contrast'' – This parameter increases the contrast of freezing.

The second is ''Details size'' – level of detail when blocking relief parts. When this value decreases, the freeze tool will be more sensible to details.

The third is ''Freeze degree'' – force of blocking smoothening when drawing with “Shift” key pressed.
14.5 Blocking can be saved to a file and loaded. In this way you can create a set of handy blocking outlines for your model. If you saved at least one file, subsequently you will have a drop list offering a selection of files displayed:
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14.6 You can get more advanced commands through “Freeze” of main menu:
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For convenience, you can pin this context menu by click the pin icon (click again to unpin), move it to the position you want, for example:
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-Toggle freeze view. There are six types of freeze view mode, which give you different visual experience:
[image: image114.jpg]



-Freeze the surface. Freeze all the surfaces with current condition.
-Invert freeze/selection. The frozen surfaces will be unfrozen; the surfaces which were not frozen will be frozen.
The other commands are very easy to understand through literal meaning, you can try and see the results yourself.

15. Fill – filling in self-contained parts with material:
[image: image115.jpg]



15.1 Fill in inside the set range of colors (if ''Use color tolerance'' is turned on) with frozen surface taken into account.

15.2 You will see an advanced menu too:
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15.2.1 Filling: 

Layer. Fill the whole layer.

Material. You can fill the material of object with the fill pattern.

Object. You can fill the sub-object with the fill pattern.
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15.2.2 If you enable ''Fill by freeze'' then you will see the menu as follows:
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Instead of color fill-in, the surface will be filled by freezing. The ''Freeze degree'' slider is responsible for maximal freeze values.

15.2.3 If you will switch in the ''Fill with smooth'' mode then smoothing will be performed over closed area instead of filling by color.

15.2.4 If you switch on the ''Lines mode'' the following menu will be displayed:
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Lines mode. To fill-in you set 2 points. The vector between them is considered the main direction when using distortions.
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15.2.5 If you have chosen the "Fill with gradient", the surface will be filled with color gradient from the main color to secondary one. Otherwise, the main color is used for filling-in. If the pen radius differs in the starting and final point of the line, then the modulation scale will smoothly change from the start to the final point. You can use gradient filling in fill tool in much more intuitive way.
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15.2.6 In case the ''Use in other tools'' option is selected, the modulation acts not only in the fill-in mode, but with the standard pen too.

15.3 There are 16 basic and user-adjustable types of modulations available:
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Each sphere corresponds to 16 types of modulations (as shown on the picture):
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− Without modulation (filling will be done without additional modulation)

− Noise (random noise)

−Gaussian noise (random modulation with Gaussian noise applied)

− Wavy surface (wavy surface y=sin(x))

− Strips (strips that are perpendicular to the main axe)

− Saw (saw-like shape)

− Hexagon (correct hexagonal grid will be used as volume texture when modulating)

− Random spheres (space filled with random spheres will be used as volume texture when modulating)

− Pores (generation of pore-like surface)

− Spots (generation of ''pimpled'' surface)

− Fractal N1 (volumetric Perlin noise)

− Fractal N2 (square of Perlin noise)

− Fractal N3 (Perlin noise limited by planes)

− Fractal N4 (cracks) (this fractal is resembling cracks)

− Fractal wood N1 (a set of distorted planes perpendicular to the view direction)

− Fractal wood N2 (a set of distorted cylinders. To set the cylinder axe, go into the lines mode)

− Fractal tree N3 (wood with knot imitation)
15.4 Custom: Rough skin
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To create the new fill pattern you should specify texture of bump and texture of color (optional). They will be mapped on object using cube mapping with soft edges. The screenshots below show the difference between usual cube mapping and mapping with soft edges.
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In this way you can textures object seamlessly in very easy way. It is easy to create materials like skin or pores. I have added a sample material — something like dino-skin.
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15.5 Depending on the modulation chosen in the "Modulation type" menu you will be offered to adjust the parameters as follows:

-Amplitude of dispersion – sphere dispersion amplitude against the correct hexagonal grate.

-Distortion degree – the degree of fractal distortions.

-Maximum position – the position of maximum.

-Scale – scale of modulation.

-Anisotropy – the degree of stretching or compression of details along the direction selected. If no direction is set, then it is a vertical axe. Switch into the lines mode to specify the direction.

-Width of jag – the relative width of jag.

-Scale of distortion - the scale of fractal distortions.

-Pores size – pores size.

-Spots size – spots size.

-Width of jag – the relative width of jag.

-Cracks width – cracks width.

-Edge contrast – this parameter determines the smoothness of edges in cube mapping.

-Bump texture – the bump texture to be used in cube- mapping.

-Color texture – the color texture to be used in cube-mapping.

-Name – the name of custom pattern.

-Delete pattern.

-Modulate depth. Select this point if you want to modulate the depth when filling-in.

Parameters:

-Depth modulator – modulation value.

-Extrusion – the addition extrusion. "-1" means that surface will only press in,

"1" – only press out.

Modulate color: select the corresponding color operation and paint with it. Vary opacity to make the effect stronger of weaker. Parameters:

-Color preference – this slider determines preference of color usage between color for convexity and concavity.

Concavity opacity – concavity opacity modulator.

Concavity color – this color corresponds to concavity.

Convexity opacity – convexity opacity modulator.

Convexity color – this color corresponds to convexity.

Modulate specular: select this option if you want to modulate specular channel. Parameters: Concavity specular – concavity specular modulator.
Convexity specular – convexity specular modulator.
15.6 Using menu Store/Restore you can store parameters of fill-in to a FILL file, located in InstallDir\UserData\StoreData\Fillers\ folder by default, load fill-in parameters from a file, choose previously saved files:
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15.7 If the fill area is big, the warning as follows will pop up:
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15.8 You are not only able to use “Fill” tool separately, but also can use it in combination with other methods. For example, we can use “Fill” tool in combination with “Material”:
- On the pictures below we have filled in a certain area with “Material”, using cubic mapping method. On edges we created freeze areas, while the inside area was filled in. Find out more about the freeze mode in clause 13 of this section. Pay attention that when lines modes and "Fill" tools are used in combination, you can fill closed spaces with color gradient, as shown on the picture below:
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16. Pipette:
[image: image132.jpg]



Pick the color and specular from a surface of an object. Use hotkey 'V'+LMB to pick the primary color and 'V'+RMB to pick secondary color outside this tool. Use 'H' to pick top layer. Use 'G' to pick depth of pen.
17. Make planer (flattens geometry on object):
[image: image133.jpg]



Left mouse-click to make the surface inside the pen flat. The pen shape is stored.

17.1 With a call of "Smoothing" command the advanced "Plane tool" menu with a set of options opens:
[image: image134.jpg]Marmal source:
Plane mode

Plane extrusion A




-Normal source (This option determines if normal and point for the plane should be taken from the first click position or from the current point)
-Plane mode:
[image: image135.jpg]Plane mode

Make planar

Make planar
Cut off
Fill mode




(1)-Make planar (make surface plane)

(2)-Cut off (cut off parts over the plane)

(3)-Fill mode (fill holes under the plane)
-Plane extrusion (allows making additional extrusion while making plane. It works like clay brush.)
18. Sculpting mode:
[image: image136.jpg]



When working with sculptural modeling you are offered 10 work modes as follows:
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18.1 Drag with pen (Hotkey F1). Drag the surface piece. Using ''CTRL'' you can drag along average normal.

18.2 Select&move (Hotkey F2). Use this mode you can select surface part and modify it – move, rotate or scale. In this mode there is a list of commands available as follows:
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18.2.1 Proposed actions:

-Select with pen or rectangle (Hotkey SHIFT A). Select with pen, rectangle or curve. Use CTRL to subtract selection, SHIFT - to add selection.

-Select with gradient (Hotkey SHIFT Q). Selection is done with gradient. Click to determine the start position o gradient and then click again to determine the end point.

-Move (Hotkey SHIFT W). Moves the selected area.

-Rotate (Hotkey SHIFT E). Rotates the selected area.

-Scale (Hotkey SHIFT R). Used for scaling of the selected area.

18.2.2 Buttons:

-Smooth. Smooth selection.

-Expand. Expand the selection.
-Clear. Clear all selection
-Wide. Make the intermediate area of selection more wide.

-Contract. Contract the selection.

-Increase. Grow the selection value on 10%.

-Store. Store selection to the file.

-Restore. Restore selection from the file.
18.3 Drag points (Hotkey F3). In this mode you can add control points and drag them (rotation and scaling can be done too). Each point limits the surface modification. Use 'DEL' to delete a selected point. Select several points simultaneously using 'SHIFT' button.
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18.3.1 Proposed actions:

- Move (Hotkey SHIFT W). Move the selected area.

-Rotate (Hotkey SHIFT E). Rotate the selected area.

-Scale (Hotkey SHIFT R). Scale selected area.

18.3.2 Options:

Delete all handlers. Delete all handlers.

Edge hardness. Increase this value if you want to transform more rigid pieces.

-Show selection. Show selection that corresponds to the selected point.

-Store. Store handlers positions to the file.

-Restore. Restore handlers position from file. This operation will add handlers from the file to existing handlers.
18.4 Draw with pen (Hotkey F4). Draw with pen. Use ''CTRL'' to press in and ''SHIFT'' to smooth the surface.

18.5 Collapse (Hotkey F5). Collapse a part of surface. Use ''CTRL'' to expand surface.

18.6 Expand (Hotkey F6). Expand surface part. Use ''CTRL'' to collapse surface.

18.7 Shift (Hotkey F7). Shift surface along pen motion in screen space.

18.8 Tangent Shift (Hotkey F8). Shift surface along pen motion in normal plane.

18.9 Flatten (Hotkey F9). Flatten the surface under the pen.
18.10 Smooth. Smooth surface with pen.
19. Retopology tool:
[image: image140.jpg]



3D-Coat offers powerful set of retopology tools. It allows you to change topology of model. In general 3D-Coat can be used as a pure retopology tool. Just open reference mesh and cover it with polygons. If reference mesh is covered with texture, 3D-Coat will be able to bake not only geometry but texture on new topology.
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19.1 Let us open "mode" menu. You can find "pin" icon there. Pin retopology "mode" menu and move the whole menu to the convenient place using the blue "drag" bar. (The example model is done by Juan Carlos Montes)
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Let us start with "Add points and faces" mode.
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Let us add points using LMB.
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Use RMB to create quads.
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You can force creating triangles instead of quads using SHIFT+RMB.
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19.2 Let’s discover other mode-"Add quads".
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There are several methods of edge extrusion. Default method requires 2-click to add face, other methods – only one click. In this case quads proportions depend on pen radius.
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You can add quad in 2-clicks in default mode.
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You can add triangle instead of quad using double click.
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19.3 Let’s discover powerful "Draw strokes" mode.
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Let’s draw several slices (Start draw at empty space to slice).
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... and one stroke.
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Select number of segments...
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And press "Enter". You will get ring of polygons with corresponding number of segments.
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Let’s draw some strokes on the surface instead of draw slices.
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Press Enter.

[image: image157.jpg]



You can easily connect clusters of strokes.
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Let's draw several circles (You can drag point to close circle. Click CTRL to break curve at some point.)
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Press Enter.
[image: image160.jpg]



By this method it is easy to make rings of polygons.
19.4 Let us discover "Tweak with brush" mode.
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Drag points with LMB and smooth using SHIFT.
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There you can select edges smoothing mode.
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19.5 Select and operate mode. There you can select elements – vertices, edges and faces and modify them.
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Select with SHIFT+LMB and draw with RMB. In almost all modes you can use RMB to drag vertices even without selecting.
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Let's select several edges. You can select edge loops, rings, partial edge loops/rings using 'L','R'. Here we select an edge rings:
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Then press Split button and move the mouse to the edges on the surface.
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Click, then you will get the edge rings split.
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Select faces 
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Press Insert on the keyboard or click Subdivide button to subdivide:
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19.6 After you have made retopologization sometimes you need to assign UV-set. Select 'Mark seams' mode. In this mode you can add seams for UV-mapping. It works exactly like UV-mapper tool.
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After marking seams press 'Unwrap' to create UV-set.
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19.7 Let’s have a look at “Retopo commands menu”:
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-Import external mesh. You can import external mesh there to continue retopologization started in other 3D-modeler.
-Export raw object. You can export retopo mesh to continue work in other 3D-modeling tool.
-Import reference mesh. Reference mesh can be imported to retopologize big objects made in other 3D modeling tools. They can contain reference to textures. In this case objects will be colored; color will be used in baking and merging into scene.
-Use current low-poly mesh. Use this option to start retopologization from current low-poly mesh. It's useful if you want to adjust slightly current topology.
-Unwrap. The same as Unwrap in Mark seams mode.
-Clear mesh. Clear the whole mesh.
-Subdivide. Subdivide the whole mesh.
-Apply symmetry. Apply symmetrical mirroring.
-Merge into scene. This command allows you to merge retopologized mesh into scene. All details from reference mesh will be baked to new object. Additional extrusion can also be applied. UV-set is required, but if you have not assigned UV-set it will be generated automatically.
-Merge hull in scene. Merge outer hull over reference object into scene. This function works like Merge into scene but optimized for multi-objected reference mesh. It prefers outer points while baking surface.
-Merge raw patch. Merge raw path into scene. No baking will be performed.
-Bake texture. Bake texture onto patch. This operation requires UV-set.
19.8 Let's discover how symmetry works in retopo tool.
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Press 'S' and select symmetry across X-axis.
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Adjust symmetry plane position using 'Tab' key. You can always tweak vertices positions using RMB. Little snapping will help you.
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The result above is only a preview; you should use 'Apply symmetry' to make symmetrical part permanent.
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19.9 Let’s have a look at these two commands:
-Z-bias. Adjust Z-bias to get better look of retopo mesh preview.
-Additional extrusion. You can extrude retopo mesh. It's good to create cloth.
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19.10 Now let’s have a deeper feel about these commands below:
-Merge into scene. This command allows you to merge retopologized mesh into scene. All details from reference mesh will be baked to new object. Additional extrusion can also be applied. UV-set is required, but if you have not assigned UV-set it will be generated automatically.
When you apply this command, window will popup:
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In this example we leave the default setting and click OK:
[image: image182.jpg]M
. ]
,I ) 4‘“‘
‘?27 /o.va.
‘ §

K</




New mesh is merged into scene. All details are projected into new mesh. Now we have created cloth for this Dinosaur, very interesting, isn’t it?
Retopology mesh becomes a new object in scene (To manage objects, go to View-Popups-Show sub-objects).
-Merge raw patch. This command can be used to merge new object without projecting details from the reference mesh.
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That's all! But this tutorial is brief. You can discover retopology deeper by reading hints over buttons. You can also watch the video tutorial from official site. 
Tips: In Retopology tool, you can always quick access to “mode” context menu by right click the mouse on blank area of screen. You can always pin the menu by click the "pin icon" at the top left of it.
20. Topological symmetry tool:
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20.1 Topological symmetry allows copying surface pieces if they have symmetrical faces structure even if they are not symmetrical geometrically. Select red face with left click and then select blue face. It is better if they will be adjacent. But anyway they should be symmetrical to each other. In so way you can define the topological symmetry.
20.2 Menu of "Topological symmetry" has a set of options:
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-Work mode – allows choosing between two modes – setup symmetry by picking two symmetrical faces or copy from one side to another using pen.

-Copy red to blue. Copy red part of mesh to the blue one. You should define them before using this tool.

-Copy blue to red. Copy blue part of mesh to red part. You should define them before using this tool.

-Flip layer. Flip layer using topological symmetry.
-Copy freeze mask(Also copy freeze mask).
-Store. Store symmetry state to .symm file.

-Restore. Restore symmetry state from .symm file.

There is an example of topological symmetry usage:
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21. Quick UV-mapper:
[image: image187.jpg]



21.1 In this mode select centers of clusters or edges that will become seams. After that you can press "Unwrap" to fit clusters on the texture. Then press "Apply UV-set" to apply the UV-set to mesh. This operation is not undoable and leads to refining of micro polygons structure.

21.2 ''Quick UV-mapper'' menu has a selection of operations as follows:
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21.2.1 Select working mode for quick-UV tool in drop list to see the following three modes:
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Add clusters. In this mode you can mark cluster centers on faces by left-clicking. Click on face again to delete a cluster.

Mark seams. In this mode you can mark seams of texturing and unmark seams using CTRL+left click. You can mark/unmark several edges with one click using "Segments num" slider.

Mark edge loops. In this mode you can mark edge loops like seams of texturing or unmark them using CTRL+left click.
21.2.2

Segments num. This option allows marking several edges in "Mark seams" mode.

Clear clusters. Clear all cluster centers and seams.

Clear seams. Clear all seams.

Auto seams. Create seams automatically.

Unwrap. Fit all clusters on texture

Apply UV SET. Apply UV set to model. Use "Unwrap" function before you will be able to apply UV-set to the model.

Store. Store UV-data to file.

Restore. Restore UV-data from file.
21.3 Window ''UV preview''

Every cluster will be unwrapped using LSCM unwrapping algorithm. When you mark a new seam or a cluster 3DC unwraps new clusters in real-time and shows you the preview of unwrapped clusters immediately, so that you can see the degree of distortion for every part. You can see new clusters appearing in real-time, lest you should forget some seam before unwrapping. Take a look at a screenshot of this tool in action below:
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Using the first mode ''Add clusters'' you can mark centers of clusters like it is shown on the screenshot:
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You can find good UV-mapping video tutorial on official site.
22. Measure distance between points:
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22.1 With a call this command the advanced "Measure tool" menu with a set of options opens:
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-Original units of the mesh. You can define there units of measurement and measure line length.

-Units to display. You should choose the units to display. There are next parameters in these combo boxes:

-Meters (m)
-Millimeters (mm)

-Centimeters (cm)
-Kilometers (km)
-Foots (ft)
-Inches (in)
-Yards (yr)
-Miles (ml)
-Scale. The scale can be used to transform units. Usually you don't need to enter this value manually.

-Length. The length of the red line.

22.2 Use ''Measure distance between points'' you should select how long 1 unit of the mesh is. Usually it is 1 m.
14. Symmetry
1. Symmetry in 3D-Coat is used for drawing on symmetric objects. To quickstart the "Symmetry" menu, use hot key "S":
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2. By default, symmetry is not activated (the first icon in the list). The second, the third and the forth icons are different types of symmetry: by axes X, Y and Z. Press ''Tab'' for changing position of plane. The fifth – reset symmetry planes into beginning of coordinates.

3. Experiment with symmetry on an object, choose symmetry by axis X. Now draw on the object. You will see that drawing occurs symmetrically (see example on the picture). Symmetry accelerates work flow almost twice the speed. Use it if you have the opportunity.
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15. Texture editor
1. With built-in 2D texture editor, you can draw in 2D&3D windows simultaneously. You can paint in 3D then the results will be shown in 2D window simultaneously and vice versa. Access to texture editor, through View->View/edit/tweak texture and UV-sets:
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You can select one UV-set in drop-list left-top of the 2D Texture editor window and try to paint in it. (The example model is done by Juan Carlos Montes):
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When you paint in the 2D Texture editor, the results will be rendered in 3D window simultaneously, and vice versa.
2. Create seamless textures. It is easy now to use 3D-Coat to create seamless textures and paint bump. Just go to File->Import image plane：
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3. Texture editor window can also be used to view the final look of textures:
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They are Color texture, Normals texture, Specular texture and even Shaded modes:
-Color:
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-Normals:
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-Specular:
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-Shaded model:
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4. Navigation in the texture window is almost the same like in 3D window, you can zoom/pan the texture whatever you want.
5. You can even tweak vertices of UV-plane in "Wireframe" mode using Right mouse button.
[image: image204.jpg]



16. View

1. Point the cursor on the "View" menu:
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2. With Popups you can show any popup window in the viewport easily. There are so many popup windows; all of them are very useful. I especially recommend you to notice these two popup windows – “Show sub-objects” and “Show object materials (surfaces)”, with these two windows, you can organize your scene of multi-objects very well, you can hide/show/lock/rename materials and sub-objects in an easy and quick way：
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3. Browse enable you access to the folders of 3DC quickly.
4. Adjust subpatching. You can improve visual appearance of mesh displacement using subpatches. Subpatch is a grid NxN over every face. Use this options only is you are sure that your video card is strong enough.
5. The list has options which can be turned on/off:

-Ortho-projection (toggle perspective/orthogonal projection)

-View low-poly model (view and edit low-poly model with normal map)
-Show 3D-grid (turn on/off 3D-grid plane in 3D viewport)
-Show 2D-grid (turn on/off 2D-grid of screen)
-Snap to grid (snap to 2D grid)
Note: 2D- grid is usually used combine with curve tools (Draw with spline, putting text on curve and putting picture along spline), with Snap to grid on, you can snap the points of the curve to the 2D-grid, then you can draw very exact shapes. For example:
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-View wireframe (show wireframe of the model)
6. You can choose model view mode in view menu.

-View shaded model– use key '5'

-Show model with environment map
-View low shaded model – ‘7’
Choose different regimes of lighting and look at an object, you see a difference at different regimes.

7. The third group in this menu you can adjust viewing (The example model is done by Jian12):

7.1 View relief only
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7.2 View unshaded model
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7.3. View only specular
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Blue, red, green strips are there in figure to show the form of object schematically.

For out from viewing relief only, a model non-shaded and specular go to regime "View shaded model".
8. UV-sets manager. If there are several objects in the scene, separate object can have a separate UV. Use this command to manage them. You can group several materials (surfaces) into single UV-set:
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9. When you call the "Options" menu you will see the list that has options which can be enabled/disabled:
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-Autosave. Use slider "Autosave time" you can adjust time for autosave. Auto saving file has name autosave.3b, which is located in the folder User Data.
-External 2D-editor. This path will be used to edit 2D-images. This editor should be able to edit PSD-files, so usually it is Adobe Photoshop. This editor will be called by “Edit”-“Sync layer with external editor/ Edit all layers in external editor/ Edit projection in external editor”.
-Near plane modulator. Tweak camera near plane to be able to move closer to surface.
-Show hints (you can hide or allow hints there. Hints are located down on a blue background).
-Show axis (Show or hide axis).
-Show "Focal shift" in top panel (Show "Focal shift" slider in top panel).

-Show "Falloff" in top panel (Show "Falloff" slider in top panel).
-Compact interface (toggle compact/full interface)
-Show import thumbnails on start page
-Show interface thumbnails on start page
Also you can identify:
-Screen space grid size (2D-grid size)

-Grid subdivision (2D- grid subdivision)

-Screen grid color
-Background color
-Grid color (3D-grid plane color)
-Interface color
-Headers color
-Text and white icons color
-Headers fonts color
-Button color
-High light color
-Hint background (hint background color)

-Hints text color 

-3D button style (use 3D style for buttons)
-Gradient in menu (use gradient style for menu )

-Environment sphere map (Here you can choose a sphere map used for “Show model with environment map”)
-Slightly lower shader quality (fast render)( Select this option if you experience performance problems).
-Use multicore optimization
-Use MRT (Use multiple render targets to speed up realtime normalmap updatings).
-Pen sensitivity (Adjust Pen sensitivity if you are using a digital pen).
-Freeze pattern scroll speed (Freeze pattern scroll speed. You can change freeze preview patterns in freeze menu).
-Mouse wheel (which parameter to change with mouse wheel)

-CTRL+Wheel (which parameter to change with CTRL+ mouse wheel)

-SHIFT+Wheel (which parameter to change with SHIFT+ mouse wheel)

-ALT+Wheel (which parameter to change with ALT+ mouse wheel)

There is a list or suggested parameters for each of the last four options:
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-Normal maps export (select the standard of normal maps exporting: 3D-Max or Maya)

-Padding (When you export textures you will be asked if you need a border around the texture clusters (padding). This option allows you to answer the question automatically)

-Padding width (padding width, used when texture exporting)
3D-Coat support 3D SpaceNavigator of 3DCONNEXION.If you are using it, you can get every control here:
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10. At the end of list of the menu "View" you can see all objects of a scene (geometry graph). You can hide or show each of objects.
17. Layers

1. Point the cursor on menu "Layers"
[image: image215.jpg]Layers Freeze Hide Language Help

= show layers st i)

Adust »
Add ew layer [CTRLASHIFT+N]

Add layer with normalmap
Delete the layer [CTRL+SHIFT+DELETE]

Erase unfrozen [DELETE]
il unfrozen [ms]
Fill by mask [CTRL+HNS]
Duplicate layer [CTRL+SHIFT+D]
symmetrical transform »
Import/export »

Merge visble layers  [CTRL+SHIFT+E]
Merge dov [CTRL+E]

Merge up

Fresze painted pixels
Fresze transparent pixels
Apply layer mask

Apply blending




and click on “Show layers list”:
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Here we see the list of layers (Layer 1 and Layer 0), effects with layers, and choices of putting a color, and modes of operations with a layer. In the list of layers we have two layers: Layer 1 and Layer 0. In this case we have Layer 1 chosen, and all operations are made for the chosen layer. The icon of an eye means that the chosen layer invisible; we can disconnect its visibility. Then we will see only layer - Layer 0. "Layer 0" is unusual layer. You see that its visibility cannot be disconnected (an icon of an eye is absent). It is the main layer, it cannot be removed. Therefore all operations above object are done in the Layer 1 by default.

At the bottom of the ''Layers'' window we see six buttons correspond to six effects for changes in a layer:
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–Add new layer (Add a new layer. It is automatically made the current one)

–Delete this layer
–Merge the current layer with the lower one. Undo is inactive.
–Duplicate layer
–Shift the layer upward (lifts the chosen layer up)

–Shift the layer downward (lowers the chosen layer down)
2. Click on dropped the list Layer 1 and you will see:
[image: image218.jpg]Depth Miifger 100

Transparency 100
ey o
Buigng 000
e

Contrast rapge 000

Brightness 000
B0

Specuiar conrast 000
Speaar brghiness (000

[ Lock layer transparency

sk wit_on't mask ]

(] Inverse masking

3 Layer 1
Layer 0

AXTCa+ e




Above we see seven effects for changes in a layer:

-Depth Multiplier
-Transparency

-Bulging
-Contrast range
-Brightness
-Specular contrast
-Specular brightness
-Lock layer transparency, which allows to draw in the layer not changing it’s transparency; not adding more details but changing color of already existing ones.

-Mask with. Mask this layer by the selected layer. Transparency and depth of current layer will be modulated by selected layer transparency.

-Inverse masking. Modulate depth and transparency of the layer by the inverse transparency of selected layer.

All parameters can be change. For this you must change value on a corresponding scale.
3. Press on Layer 1 and click right button mouse then you will see the list with operation:
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-Duplicate layer
-Duplicate and flip (Duplicate the layer and flip using topological symmetry)

-Flip layer (Flip the layer using topological symmetry)

-Copy blue to red (Copy blue part of mesh to red part. You can define blue and red parts in the topological symmetry tool)

-Copy red to blue (Copy red part of mesh to the blue one. You can define blue and red parts in the topological symmetry tool)

-Merge visible layers (Merges all visible layers. ''Undo" is unavailable)

-Merge up (Merge this layer and the upper layer. "Undo" is unavailable)

-Freeze painted pixels (The freeze value will be set equal to layer's transparency)

-Freeze transparent pixels (Freeze transparent part of layer. It is important if you want use mask of transparency of current layer on another layer. Use ''CTRL'' + Click on layer to do the same action)

-Apply layer mask (Apply layer mask to layer. Layer mask is a reference to another layer that masks this layer)

-Color to specular (Transforms color brightness to the specular channel)

-Invert color (Inverts color of this layer)

-Invert specular (Inverts specular of this layer)

-Fill unfrozen (Fills unfrozen parts of layer with current color and specular)

-Fill by mask (Fills layer with current color and specular using its current transparency mask)

-Set height to Zero (Sets height to Zero in all the layers)

-Make transparent (The layer will become fully transparent)

-Remove specular (Specular channel will be set to Zero)
4. You can rename the layers by double clicking on the name of it, then a text input box will popup:
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5. The following image is an example of using the ''Layers'' menu:
[image: image221.jpg]



6. One layer can mask another layer in non-destructive way.
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7. You can freeze the transparent or painted area of the layer. In this way you can use layer's transparency to paint selectively on another layers. It is like ''CTRL'' + click on layer in Photoshop. You can use ''CTRL'' + click on layer in 3DC now.
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8. You will get many layer adjustments commands through “Layers”-“Adjust” menu:
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Such as Smooth current layer, Sharpen current layer, Correct hue/saturation/lightness, Correct CMKY, Transform color space, Brightness/contrast, Correct RGB. All of them have realtime previews and ability to apply not only to current layer but also to all the layers:
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9. There are also many other commands through “Layers” of main menu, most of them are very similar with the layers commands in Photoshop, try out every command yourself, keep in mind that there are very detailed hints of every command, they will help you a lot.
18. Edit
1. Point the cursor on the "Edit" menu to see the following:
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2. Undo.

3. Redo.
4. Change. Here you can change the parameters related to pen, include: opacity, angle, radius, degree, smooth degree, specular opacity and specular degree. You can also swap first and second color using Swap colors here.
5. Sync layer with external editor. This command allows you to synchronize the current layer with external editor. You can set the path to the editor in options. By default it is Adobe Photoshop. The alpha channel will contain the transparency mask. When you call on this command the program Adobe Photoshop will be open automatically with your file. Then you can change it and jump back to 3D-Coat pressing Ctrl+ S.
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6. Edit all layers in external editor. Edit all layers in external editor. You can change the editor in options menu (it is Adobe Photoshop by default). This editor should be able to edit PSD - files. The texture will be stored with layers to the PSD - file, the Adobe Photoshop will run (if installed). Then you can edit the texture and even add new layers. When you will save it, 3D Coat will automatically load it.
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7. Edit projection in external editor. You can edit the current projection in Adobe Photoshop using layers. You can change the editor in options menu (it is Adobe Photoshop by default). This editor should be able to edit PSD - files. The projection will be saved with layers into PSD file, then Adobe Photoshop will run (if installed). Then you can edit the texture and even add new layers. When you will save it, 3D-Coat will automatically load it.
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8. Change mesh and texture resolution (it changes the number of polygons of the object and size of texture. You can change mesh resolution multiple times (like other software usually does), but also can in percentage, for example 50%).
9. Offset tool. In case the object is not square, then a message pops up to warn you that you should load plane1x1.OBJ without smoothing to be able to use offset tool. This tool comes in handy to create tiled textures with bump and specular. Once a square object is loaded, you will be offered the ''Offset tool'' window where offset values can be specified:
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- U offset, V offset – texture shifting horizontally and vertically in accordance;

- Reverse shift – when activated, the option does revert shifting.

10. Calc occlusion. This tool allows calculating the global illumination from many spot lights that are distributed over the half-sphere. The grey scale results will be written to the current layer. So it is better to create a new layer and set color operation "Modulate" or "Modulate2X". Occlusion calculation tool is especially optimized for high polygons (several millions), it is fast but you know that it's still need some time in such high polygons:

10.1 You pressing on "Calc occlusion" the warning will appear:
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Here you can define:

–Light sources (distribution of lights): 
1) over hemisphere 
2) over sphere 
3) over hemisphere + sphere

–Lighting render target (Place where will be rendered the result of light calculations. You can choose to add new layer automatically or overwrite the current layer. In the first case you do not forget to delete a new layer for light calculation. Also a new color option "To time" is installed for a new layer. In the case of rendering the former layer all its color information will be deleted).

–Lights count (The time of calculation is proportional to that amount. The more light sources are there the better is the quality of lighting but the longer its calculation. The maximal value is 256, the minimal value – 16. The example of occlusion is shown below).

–Post-smoothing steps. (Amount of post smoothing steps after occlusion calculation).
10.2 The first example – this object with render of 16 of light sources. The second example – this object with render of 128 of light sources. In these examples difference in occlusion is clearly visible on a thorax of the image of the person.
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19. Texture baking tool
1. You can use texture baking:

1) To get correct displacement maps even in case when you have dragged surface in sculpt tool.

2) Sometimes you need to change topology or UV-set of a mesh. For example you need to simplify a mesh and get textures for the simplified mesh. Here's where texture baking comes in handy.

2. If you choose ''Texture baking tool'' in the ''File'' menu you will see the window offering a string of options:
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To get displacement map you should set "Smooth mesh" option because displacement is calculated as the difference between the object in scene and the smoothed input mesh. Check "Use current low poly mesh..." option if you want to project on current mesh. In this case it is better to check options" Use original positions..." and "Smooth mesh" if you want to get displacement and uncheck them if you want normalmap only.

There are several typical settings for baking tool:

a) Baking displacement:
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b) Baking normalmap for low poly mesh:
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There is no need to get normalmap and displacement simultaneously. If you have no deep cavities it is always better to use normalmap.
3. Baking tool is especially important if you want to get a texture for low-poly mesh as a result.

3.1 As an example, let's take a sphere and draw the strip over it like shown below:
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3.2 Then we should go to sculpt tool and distort it slightly using drag with pen tool:
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3.3 Then we should enter into the low-poly mode. You will see:
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As you have distorted geometry, but left the texture undistorted, the mesh looks improperly in the low-poly mode. In this case baking tool can help you out. You should project the new high-poly distorted mesh onto the low-poly mesh. This is the way you get distorted textures. Here's the comparison result for usual export of normalmap texture and that of baking tool:

3.3.1 Simple export result:
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3.3.2 Baking tool result:
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3.4. The difference is obvious - using baking tool you have got the correct normal map.

3.4.1 The options for taking that normalmap are below:

[x] Use current low-poly mesh...

[ ] Use original positions...
[ ] Smooth mesh
3.4.2 The options should be different if you need displacement:

[x] Use current low poly mesh
[ ] Use original positions...

[x] Smooth mesh
[x] Preserve positions...
The results however, will be better if you don't need displacement and need normalmap only. It is due to getting displacement is not a trivial operation and the mesh should be smoothed prior to that. It is necessary because the displacement is difference between mesh and smoothed surface. We think that simple example shows you why baking tool is so important.
20. Default hot keys
Legend:

LMB="left mouse button"

RMB="right mouse button"

MMB="middle mouse button"

Navigate camera:

Rotate (ALT+LMB)

Zoom (ALT+RMB)

Pan (ALT+MMB)

You can use "LMB+RMB" instead of "MMB".

File:

Open file (CTRL+O)

Save file (CTRL+S)

Save file as (CTRL+ALT+S)

Save incrementally (CTRL+SHIFT+S)

Import model (CTRL+SHIFT+O)

Import image plane (CTRL+SHIFT+M)

Edit:

Undo (CTRL+Z)

Redo (CTRL+Y)

Edit all layers in external editor (CTRL+P)

Edit projection in external editor (CTRL+ALT+P)

Offset tool (CTRL+SHIFT+F)

View:

Ortho-projection (NUM5)

View relief only (1)

View unshaded model (2)

View only specular (3)

View wireframe (4)

View shaded model (5)

View low-poly model (6)

View low shaded model (7)

Show 2D grid (CTRL+')

Popups:

Color picker (B)

Show palette (F)

Show layer list (L)

Show tools panel (SPACE)

Depth channel (D)

Color channel (C)

Specular channel (R)

List of pens (T)

List of materials (M)

Types of drawing (E)

Quick panel (~)

Symmetry (S)

Layers operations:

Add new layer (CTRL+SHIFT+N)

Delete the layer (CTRL+SHIFT+DELETE)

Erase unfrozen (DELETE)

Fill unfrozen (INS)

Fill by mask (CTRL+INS)

Duplicate layer (CTRL+SHIFT+D)

Merge visible layers (CTRL+SHIFT+E)

Merge down (CTRL+E)

Freeze operations:

Toggle freeze view (ALT+F)

Unfreeze all (CTRL+D)

Invert freeze/selection (CTRL+SHIFT+I)

Show/hide freeze (CTRL+F)

Smooth freezing (CTRL+NUM*)

Expand frozen area (CTRL+NUM+)

Contract frozen area (CTRL+NUM-)

Freeze border (CTRL+NUM/)
Hide operations:

Unhide all (CTRL+X)

Expand hidden area (NUM+)

Contract hidden area (NUM-)

Drawing operations:

Pressing out (LMB) 

Pressing in (LMB+Ctrl) 

Smoothing (LMB+SHIFT) 

Increase pen radius ([)

Decrease pen radius (])

Clockwise angle of pen rotation (()

Counterclockwise angle of pen rotation ())

Increase pen depth (+)

Decrease pen depth (-)

Smoothing:

Increase level of smoothing (SHIFT++)

Decrease level of smoothing (SHIFT+-)

Specularity:

Increase opacity of specularity (/)
Decrease opacity of specularity (;)

Color:

Increase transparency of texture (P)

Decrease transparency of texture (O)

Regime of a spline:

Add point to a spline (LMB)

Draw extruded curve (ENTER) 

Pressed in one (CTRL+ENTER)

Delete all points (ESC)

Delete the last point (BACKSPACE)

Symmetry

Change the position symmetry plane (TAB+moving your mouse)

Regime of copying and insert:

Insert a copied part (CTRL+V)

Copy a part (CTRL+C)

Creation of a new pen from a site (CTRL+SHIFT+C)
Pick color (V)

Pick layer (H)
21. Customize hot keys & User Interface
In 3D-Coat, the UI and hot keys are full customizable; you can customize your own UI & hot keys in an easy and quick way. All the UI & hot keys and other customized information are stored in a small size of .xml file, you can save it then anytime you want you can load it, or even share your customization with your friends. All these things are with a lot of fun.
1. Customize hot keys:
1.1 Customize hot keys in 3D-Coat is very easy. For example, we would like to define a hot key for “Show 3D-grid” command.
First point your mouse cursor to “View” – “Show 3D-grid”.
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Then press “END” key on the keyboard, a hint will popup:
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At this time you simply press the key you want to assigned with “Show 3D-grid”, for example we press “G” key on the keyboard. Want more steps? No, it’s just done, just so easy. Now you can show/hide 3D-grid with “G” key:
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1.2 If the command is already assigned with a key, you can also change it to your own key, the same steps as 1.1.
2. Customize User Interface
2.1 The UI of 3D-Coat are full customizable, but before we talk how to customize the UI, first let’s have a look at the UI themes presented in 3D-Coat. Let go to “View” – “Options” – “Load”, you will be directed to a folder named “OptionsPresets”, there are 13 .xml files in it, each ot them is corresponding to a theme, to load the themes, simply select one .xml file and click “Open”.
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BrightWhite/DarkPlanar
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Default (WindowsXP)/Green
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Light/LightCold
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LightPlanar/OldDarkstyle
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SoftBlue/SoftGreen
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VeryDark/Yellow
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2.2 You can create you own UI theme and save it as an .xml file. Just go to “View” - “Options”:
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here you can customize color of texts/interface/header/buttons/grid/background, etc...

You can also turn on/off "3D button style"/"Gradient in menu", decide whether show "import thumbnails"/"interface thumbnails" or not. You can even turn on "Compact interface" that will make some of the panels smaller.
After all these done, just save the .xml file, all the UI & hot keys and other customized information are stored in it. You can load it anytime or share with your friends. Simply press the button “Save” in Options panel.
2.3 You can even change the icons of the tools to you own, just go to the installation folder of 3D-Coat, in the path “textures\icons” you will find the source PSD files of the icons, they are “baseicons.psd” and “SmallIcons.psd”, open the PSD file in Photoshop and draw your own icons.
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When finished, save them as DDS format, keep the name and replace the original “baseicons.dds” and “SmallIcons.dds”. Next time you start 3D-Coat, it will load the new icons.
22. FAQ/Additional tips
1. There are too many texts (hints) of the interface, is there a way to hide them?
If you are new to 3D-Coat, it isn't recommended that you hide the hints, because the "hints" system will really be helpful for your study. But anyway, you can hide it anytime you want, just go to "View"-"Options"-"Show hints" and uncheck this checkbox.
2. Can I move/rotate/scale the objects but not the camera?
Yes, you can. In "Sculpt mode" of tools panel, select "Select & move" command, here you can select the object you want to move/rotate/scale.
3. How to adjust pivot point?
In 3D-Coat,the pivot center is dynamic, current pick point (where you cursor pointed on the model)is the pivot.  
4. What's the normalmaps standards difference between 3ds Max and Maya?

The green channel is reversed. You can select normalmaps standards in "View"-"Options".
5. When DX and When GL?
It depends on your hardware. 3D-Coat has two Graphics Modes: DX (DirectX) and GL (OpenGL), usually GL mode runs much faster than DX mode on professional Quadro graphics card, while DX mode will run well on game graphics card.  
6. What’s the difference between “Depth” and “Sculpt mode”?
In 3D-Coat there are two types of sculpting. One is Image-based Sculpting and another is Mesh-based Sculpting. 
“Depth” is Image-based Sculpting, in this mode you drawing the depth, you’re actually creating vector displacement, the normal map and displacement is generating "on the fly", if you want to get the normal map, just save it, no need to wait long time for baking, because the normal map is generated in realtime.
When you entered “Sculpt mode”, you entered Mesh-based Sculpting. In this mode you sculpting, you’re really changing the vertex positions of the mesh. In this mode if you want to get correct normal map, you may use “File” - “Texture baking tool”.
7. What’s the usage of Cavity painting?
Cavity painting (depend on Cavity) allows you to paint in the crevices of the surface without affecting the rest of the area, and vice versa.
8. My scene have multi-objects, is there an easy and quick way to hide/show/lock/rename sub-objects?
Yes, at “View” - “Popups” there are two popup windows named ”Show sub-objects” and “Show object materials (surfaces)”,with these two windows, you can organize your scene of multi-objects very well, you can hide/show/lock/rename materials and sub-objects in an easy and quick way:
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9. I selected the command “Show model with environment map”, but there seems no change, why?
“Show model with environment map” is only affected with the area with “specular” of the model. That means if you haven’t paint specular on the model, you will not see any change. This example we create a new layer and fill this layer only with “specular”, then use “Show model with environment map”, you will see the results:
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10. Draw with "SHIFT" key

Different orders of "SHIFT" key and "LMB (left mouse button)" will result in different effects. 
If you first press (and hold) "SHIFT" then draw with "LMB", you will get the surface smoothed. But if you first press (and hold) "LMB" then press "SHIFT" and draw, you will get very straight line just like the way in Photoshop.
11. Usage of presets panel
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Use ''Add preset'' button to add new presets.

In the ''Options'' menu you can enable/disable the options as follows:

- Store pen shape
- Store strip shape
- Store pen radius
- Store pen depth
- Store focal shift
- Store smooth degree
- Store colors
- Store opacity
- Store specular
- Store specular opacity
- Store material state - pictures, mapping type, transform parameters material

- Store fill pattern in fill tool
You can select several pen shapes simultaneously and draw with a random pen. Also you can store it into new presets window. In this way you can make hair or skin details easily. The screen below shows how multiple selection and presets panel looks like:
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12. Create seamless textures using 3D-Coat
It is easy now to use 3D-Coat to create seamless textures and paint bump. Just go to “File” – “Import image plane”, you may want to us “Edit” - “Offset tool” as well.
13. Usage of 2D-grid
2D- grid is usually used combine with curve tools (Draw with spline, putting text on curve and putting picture along spline), with Snap to grid on, you can snap the points of the curve to the 2D-grid, then you can draw very exact shapes. For example:
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14. Memory management tuning and increasing stability
When 3DC is run you can see the amount of free memory at left bottom corner. If this value becomes too low (200-300M) the program can work unstably. This tutorial will help you to increase stability in easy way. 3D-Coat consumes much memory for high detailed objects, so it is important to allow 3D-Coat to use as much virtual memory as possible. So, please adjust virtual memory settings as it shown on the picture (it is valid for 32-bit Windows XP)
MyComputer->Properties->Advanced->Performance->Addvanced->Virtual Memory->Change
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Please set there 4096 K.

Since 2.07, 3D-Coat supports larger virtual memory range support. If you are using 64-bit windows you will be able to use up to 4GB of virtual memory. So, using 64-bit windows with 3DC is a best choice. If you are using 32-bit windows, you can usually use 2 GB of virtual memory, but you can increase that size using special option /3GB in the file boot.ini. Using the option you will be able to use 3GB of memory with 3DC. Of cause you should be careful with that file.
How to find the file boot.ini?
1) Right-click My Computer and select Properties. The System Properties dialog box will appear.

2) Click the Advanced tab.

3) In the Startup and Recovery area, click Settings. The Startup and Recovery dialog box will appear.

4) In the System startup area, click Edit. This will open the Windows boot.ini file in Notepad.

5) In the [Operating Systems] section, add the following switches to the end of the startup line that includes the /fastdetect switch: /3GB

6) Save the changes and close Notepad.

7) Click OK two times to close the open dialog boxes, and then restart the computer for the change to take effect.
You can read more about /3GB option here

http://technet.microsoft.com/en-us/library/bb124810.aspx
http://www.vfxpedia.com/index.php?title=FAQ/3GB_Switch
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